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Tablet computer

Supercomputer
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1.Which of the following is NOT a type of personal computer?
  निम्नलिखित में से कौन-सा पर्सनल कं प्यूटर का एक प्रकार नहीं  है?  

*

2. In an OpenOffice Calc, which function returns a text string that includes
repetitions of another text string?
  ओपन ऑफिस कै ल्क (OpenOffice Calc) में, कौन-सा फ़ं क्शन एक टेक्स्ट स्ट्रिं ग रिटर्न
करता है जिसमें एक अन्य टेक्स्ट स्ट्रिं ग के  पुनरावृत्त (repetitions) शामिल होते हैं?   

*



1/1

low-level

high-level

advanced-level

procedural-level

1/1

End-to-end encryption

Hash function

Digital Signature

Digital Certificate

3. The _________ language is also called a machine language.
  निम्नलिखित में से किस भाषा को मशीन भाषा भी कहा जाता है?   

*

4. Everything sent via WhatsApp is protected with a feature where no one
else can read or listen to your messages or calls aside from you and the
recipient.What is that feature called?
  व्हाट्सएप के  माध्यम से भेजी जाने वाली प्रत्‍येक चीज एक ऐसी सुविधा (feature) से
सुरक्षित है जहां आपके  और प्राप्तकर्ता के  अलावा कोई भी आपके  संदेशों या कॉल को पढ़
या सुन नहीं  सकता है। उस विशेषता को क्या कहते हैं?   

*
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Tab key

Home key

Caps Lock key

Ctrl key

1/1

Username

@ Symbol

Email provider's domain

User domain

1/1

Microphone

Mouse

Scanner

Plotter

5. Which of the following is used to make all letters capital without having
to use the Shift key for each character on a computer keyboard?
  कं प्यूटर कीबोर्ड पर प्रत्येक अक्षर के  लिए Shift कुं जी का उपयोग किए बिना सभी
अक्षरों को बड़े (capital) अक्षर बनाने के  लिए निम्नलिखित में से किसका उपयोग किया
जाता है?  

*

6. Which of the following is NOT a part of an email address?
  निम्नलिखित में से कौन ईमेल एड्रे स का हिस्सा नहीं  है?   

*

7. Which of the following is NOT an input device?
  निम्नलिखित में से कौन-सा एक इनपुट डिवाइस नहीं  है?   

*
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Gmail

Outlook

Kloser

Yahoo

1/1

Alt + F

Alt + H

Alt + N

Alt + G

1/1

AACD (Advanced Access Content Device)

AACS (Advanced Access Content System)

ACAD (AutoCAD)

AASC (Anti-aircraft Searchlight Company)

8. Which of the following is NOT a webmail provider?
  निम्नलिखित में से कौन एक वेबमेल प्रदाता नहीं  है?   

*

9. Which of the following commands is used in MS Word 2019 to go to
the File tab?
  फाइल टैब पर जाने के  लिए MS Word 2019 में निम्न में से किस कमांड का उपयोग
किया जाता है?   

*

10. What copy protection scheme does Blu-ray use?
  ब्लू-रे  किस कॉपी प्रोटेक्शन स्कीम का उपयोग करती है?   

*
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Google Docs

WordPad

MS Access

MS Word

1/1

http://abc.net

abc@yahoo.com

www.yahoo.com

D:\abc\xyz.com

1/1

Hewlett Packard Graphic Language

Higher package Graphic Language

Hewlett Packard General Language

Higher Package General Language

11. Which of the following is NOT an example of a word processor?
  निम्नलिखित में से कौन-सा वर्ड प्रोसेसर का उदाहरण नहीं  है?   

*

12. Which of the following is a valid email address?
  निम्नलिखित में से कौन-सा, एक मान्य ईमेल एड्रे स है?  

*

13.What does HPGL stands for with reference to printers?
  प्रिंटर के  संदर्भ में HPGL का पूर्ण रूप क्‍या है?   

*

https://www.google.com/url?q=http://abc.net&sa=D&source=editors&ust=1767346593596754&usg=AOvVaw1fnS1vHF0qjKTooUolpchF
mailto:abc@yahoo.com
https://www.google.com/url?q=http://www.yahoo.com&sa=D&source=editors&ust=1767346593596947&usg=AOvVaw2mwuWCOiZRRMjeNIAXNdhS
https://www.google.com/url?q=http://xyz.com&sa=D&source=editors&ust=1767346593597013&usg=AOvVaw3fIQTJsuwdxOT98dSRscii
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Clipboard

Font

Paragraph

Tables

1/1

File

Page Layout

Design

Help

1/1

The printer driver cannot be installed without a CD.

By buying another printer.

By downloading the latest driver from the manufacturer's website.

By hiring a person to install the printer.

14. Which of the following is NOT an option of the Home tab in MS Word
2019?
  निम्नलिखित में से कौन-सा MS Word 2019 में होम टैब का विकल्प नहीं  है?   

*

15. To go to backstage view in MS Excel 2019, which of the following
options is used?
  MS Excel 2019 में बैकस्टेज व्यू में जाने के  लिए निम्न में से किस विकल्प का प्रयोग
किया जाता है?   

*

16. Which of the following is an efficient way of installing a printer driver,
if the installation CD is lost?
  यदि आप इंस्टॉलेशन सीडी खो देते हैं, तो प्रिंटर ड्रा  इवर को इंस्टॉल करने का एक
प्रभावी तरीका निम्न में से कौन-सा है?   

*
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PC

Network

Video-CD

floppy

1/1

low

high

moderate

zero

1/1

CGI

CAD

JPG

IGF

17. The Moving Picture Experts Group (MPEG-1) standard is widely used
for applications such as ________.
  मूविंग पिक्चर एक्सपर्ट्स ग्रुप (MPEG-1) मानक का व्यापक रूप से ________ जैसे
अनुप्रयोगों के  लिए उपयोग किया जाता है।   

*

18.Lossy compression contains ______ compression ratio.
  हानिकारक संपीड़न (Lossy compression) में ______ संपीड़न अनुपात होता है।   

*

19. In recent movies, ______ is used frequently for creating animation
effects.
  हाल की फिल्मों में, एनीमेशन प्रभाव बनाने के  लिए अक्सर ______ का उपयोग किया
जाता है।   

*
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readable

corrupted

tampered

hacked

1/1

0 (00000000) to 255 (11111111)

1 (00000001) to 255 (11111111)

0 (00000000) to 256 (100000000)

255 (11111111) to 255 (11111111)

1/1

0 (00000000) से से 255 (11111111)

1 (00000001) से से 255 (11111111)

0 (00000000) से से 256 (100000000)

255 (11111111) से से 255 (11111111)

20. With reference to cryptography, Keys make the encrypted data ______.
  क्रिप्टोग्राफी के  संदर्भ में, कुं जियाँ एन्क्रिप्टेड डेटा को ______ बनाती हैं।   

*

21.Each 8-bit number in a 32-bit IPv4 address is converted from binary to
a decimal number, ranging from _______.
  32-बिट IPv4 पते में प्रत्येक 8-बिट संख्या को बाइनरी से दशमलव संख्या में परिवर्तित
किया जाता है, जिसकी सीमा _______ होती है।   

*

22. Which of the following printers emits small amounts of ozone which
is hazardous to health?
  Which of the following printers emits small amounts of ozone which is
hazardous to health?   

*



1/1

Sequential execution of two or more different and independent programs by a
computer

Sequential execution of only two different and independent programs by a
computer

Interleaved execution of only one different and independent program by a computer

Interleaved execution of two or more different and independent programs by a
computer

1/1

hierarchical

tabular

sequential

linked

23.What is multiprogramming?
  मल्टी प्रोग्रामिंग क्या है?   

*

24. The files and folders in folder view using Windows Explorer in
Windows 7 are viewed in _______________ structure/order.
  विंडोज 7 में विंडोज एक्सप्लोरर का उपयोग करते हुए फोल्डर व्यू में फाइल और
फोल्डर को __________ संरचना / क्रम में देखा जाता हैं।   

*
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Executing

Running

Waiting

Terminated

1/1

class

txt

java

exe

1/1

It is one of the most energy intensive applications.

It is one of the most energy saving applications.

It is an the application that does not affect computer energy.

It is an the application that improves the overall performance of the system.

25.Which of the following is NOT a name of process state in operating
systems?
निम्नलि खि त में में से से कौ न ऑपरे  रे टिं टिंग सि स्टम में में प्रक्रम अवस्था (process
state) का ना म नहीं  हीं  है है?

*

26. What is the file extension for java source code files?
जावा सो र्स र्स को ड फा इलों लों के  के  लि ए फा इल एक्सटें टेंशन क्या हो ता है है?

*

27. Which of the following best describes gaming applications of a
computer in terms of energy consumption?

*
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Ethernet

SMPS

Either USB or PS2

VGA

1/1

connect to your router

find your router's IP address

Keep searching router on internet

Log in using a web browser

1/1

Spacebar

Esc

Enter

Ctrl

28. A mouse connector can be of which of the following types?
  एक माउस कनेक्टर ______ प्रकार का हो सकता है।   

*

29.Which of the following is NOT a step to connect to a router's web
interface?
  निम्नलिखित में से कौन-सा राउटर के  वेब इंटरफ़े स से कनेक्ट करने का चरण नहीं  है?   

*

30. Which of the following keys is used to create a new paragraph in MS
Word 2019?
  MS Word 2019 में एक नया पैराग्राफ बनाने के  लिए निम्न में से किस कुं जी का उपयोग
किया जाता है?   

*
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Alt + F

Alt + H

Alt + N

Alt + G

1/1

Page Setup

Styles

Editor

Arrange

31. Which of the following commands is used to go to the Design tab in
MS Word 2019?
  MS Word 2019 में Design tab पर जाने के  लिए निम्न में से कौन-सी कमांड का
उपयोग किया जाता है?   

*

32.  Which of the following options in MS Word 2019 is used to change
the structure and layout of pages in a document?
  MS-Word 2019 में निम्नलिखित में से कौन-सा विकल्प किसी डॉक्यूमेंट में पृष्ठों की
संरचना और लेआउट को बदलने के  लिए उपयोग किया जाता है  

*
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I – True, II – True

I – True, II – False

I – False, II – True

I – False, II – False

1/1

MS Word was developed by IBM.

MS Word does not support the mail-merge feature.

MS Word is also called as 'word processor'.

MS Word was developed mainly for accounting purposes.

33. State whether the following statements are true or false:
I) Mail Merge is an appealing feature of MS PowerPoint.
II) The 'Justify' alignment distributes text evenly between the left and
right margins in an MS Word document.
  निम्नलिखित कथनों के  संबंध में बताइए कि वे सत्य हैं या असत्य: I) मेल मर्ज MS
PowerPoint की एक आकर्षक विशेषता है। II) 'जस्टिफाई' एलाइनमेंट MS Word
दस्तावेज़ में टेक्स्ट को बाएँ  और दाएँ  मार्जिन के  बीच समान रूप से वितरित करता है।  

*

34. Identify the correct statement from the given options.
  दिए गए विकल्पों में से सही कथन को पहचानिए।   

*
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Delete button

Forward button

Reply button

Answer button

1/1

LAN

Web

Hypertext

Internet

1/1

software

webpages

websites

interconnected networks

35. Which of the following buttons is clicked to answer an email
message?
  आप जब इंटरनेट पर प्राप्त ई-मेल संदेश का जवाब देना चाहते हैं, तो आप निम्न में से
किस बटन पर क्लिक करते हैं?   

*

36. The vast network of computers that connects millions of people all
over the world is called the _________.
  कं प्यूटरों का विस्तृत नेटवर्क , जिसके  अंतर्गत दुनियाभर के  लाखों लोग जुड़े होते हैं,
उसे_________ कहा जाता हैं।   

*

37. The internet is a system of _________.
  The value of the MS Excel 2019 expression '=AVERAGE(SUM(1,2),
SUM(2,3))' is:   

*
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0

4

8

Error

1/1

Charles Babbage

John Von Neumann

Alan Turing

Bill Gates

1/1

W3

FTP

HTTP

Telnet

38. The value of the MS Excel 2019 expression '=AVERAGE(SUM(1,2),
SUM(2,3))' is:
  MS-Excel 2019 व्यंजक '=AVERAGE(SUM(1,2), SUM(2,3))' का मान क्‍या है?   

*

39. ________ introduced the concept of 'stored program computer'.
  ________ ने "स्टोर्ड प्रोग्राम कं प्यूटर" की संकल्पना शुरू की।   

*

40.Which of the following protocols is the foundation for WWW?
  निम्नलिखित में से कौन-सा प्रोटोकॉल WWW का आधार है?

*
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Talkomatic

Talktonik

Speaktalk

Speakmate

1/1

HTTP (Hypertext Transfer Protocol)

DHCP (Dynamic Host Configuration Protocol)

TCP/IP (Transmission Control Protocol/Internet Protocol)

SMTP ( Simple Mail Transfer Protocol)

41.Which of the following was the online chat system created by Doug
Brown and David R Woolley in 1973 on the PLATO System at the
University ofIllinois?
  निम्नलिखित में से कौन-सा ऑनलाइन चैट सिस्टम डौग ब्राउन (Doug Brown) और
डेविड आर वूली (David R Woolley) द्वारा 1973 में इलिनोइस विश्वविद्यालय में प्लेटो
(PLATO) सिस्टम पर बनाया गया था?  

*

42. A method to transfer mail from one server to another is implemented
by:
  एक सर्वर से दू सरे  सर्वर पर मेल स्थानांतरित करने की विधि निम्नलिखित में से किसके
द्वारा कार्यान्वित की जाती है?   

*
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Work Area

Collapse

Ribbon

View Options

1/1

=9-2*3+4/2

=1+2*3-8/2

=8-2*3+8/2

=2*3-4/2

43. Which of the following is used to display a group of related
commands within the tabs of MS PowerPoint 2019?
  MS PowerPoint 2019 के  टैब में संबंधित कमांड के  समूह को प्रदर्शित करने के  लिए
निम्न में से किसका उपयोग किया जाता है?  

*

44. In an MS Excel 2019 spreadsheet, which of the following is the
formula that equates to 6 is ______.
  MS Excel 2019 स्प्रेडशीट में, निम्नलिखित में से कौन सा सूत्र 6 के  बराबर है ______।   

*
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the X-axis (independent) and derived (dependent variable) value on the Y-axis

the X-axis (dependent variable) and derived (independent variable) value on the Y-
axis

the X-axis

the Y-axis

1/1

cell

logic

value

paragraph

45. In MS Excel 2019, when you plot the data on a 2-D type of graph, the
known value goes on ______.
  MS Excel में IF फ़ं क्शन का उपयोग अक्सर तब किया जाता है जब आप अपने डेटा को
किसी दिए गए ______ के  अनुसार सॉर्ट करना चाहते हैं।   

*

46. The IF function in MS Excel is often used when you want to sort your
data according to a given ______.
  MS Excel में IF फ़ं क्शन का उपयोग अक्सर तब किया जाता है जब आप अपने डेटा को
किसी दिए गए ______ के  अनुसार सॉर्ट करना चाहते हैं।   

*
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Error

18

18.6

19

1/1

xlcx

dll

xlsx

docx

47.In default settings, what is the result of the MS Excel 2019 function
=SUM(13.3, 5, -3.5, 8, -4.2) in a spreadsheet?
  डिफ़ॉल्ट सेटिंग्स में, MS Excel 2019 में फ़ं क्शन =SUM(13.3, 5, -3.5, 8, -4.2) का
परिणाम स्प्रेडशीट में क्या होगा?   

*

48. By default, an MS Excel 2019 spreadsheet file has the extension
______.
  डिफ़ॉल्ट रूप से, एक MS Excel 2019 स्प्रेडशीट फ़ाइल का एक्सटेंशन ______ होता
है।   

*
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AMPLE

SAMPLE

SMPLE

ASAMPLE

1/1

the picture is simple and easy-to-understand

the data can be represented visually as a fractional part of a whole

it helps in providing an effective communication tool for even the uninformed
audience

it becomes less effective if there are too many pieces of data to use

1/1

histogram

pie chart

line chart

scatter chart

49. What is the output of the following MS Excel 2019 formula?
=SUBSTITUTE("AMPLE","A","SA")
  निम्नलिखित MS-Excel 2019 सूत्र का आउटपुट क्या है?
=SUBSTITUTE("AMPLE","A","SA")  

*

50. All of the following are the advantages of a pie chart, EXCEPT:
  निम्नलिखित में से किस को छोड़ कर सभी एक पाई चार्ट के  लाभ हैं?   

*

51. A ______ provides a visual interpretation of numerical data by showing
the number of data points that fall within a specified range of values
called bins.

*



1/1

the X-axis

the Y-axis

legend

background
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52. In a histogram graph, ______ shows the number of times that the
values occurred, within the interval shown on the X-axis.
  हिस्टोग्राम ग्राफ में ______, X-अक्ष द्वारा निर्धारित अंतराल के  भीतर मानों के  होने की
संख्या को दर्शाता है।  

*
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